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COURSE CERTIFICATION  REQUEST 
AND  

COURSE CHANGE OR DECERTIFICATION REQUEST 
 
1. An agency as defined in NAC 289.310, may apply for certification above the level of basic training for a course by 

submitting to the Executive Director of the Commission on Peace Officers’ Standards and Training, the following: 
 (a) A concise synopsis of the course including the title of the course, the intended goals of the course, and 

specific objectives for the students in the course; 
 (b) A detailed lesson plan including a chronological list of the major subject headings; 
 (c) A list of intended instructors, including a brief resume of experience in the subject area and experience in 

instructing for each instructor; 
 (d) The total amount of hours of instruction;  
 (e) A description of the written or practical application examinations on the material covered by the course 

which is to be graded on a pass / fail basis and which measures accomplishments of the objectives by the 
students, including an examination at the beginning and end of the course; and 

 (f) A bibliography of reference material utilized to develop the course. 
 
2. The Executive Director will award certification of a course to an agency which did not comply with the provisions of 

Subsection 1 for a course which has been certified by another state or other comparable agency if the submitting 
agency presents the supporting documents concerning the subject matter and instructors. 

 
3. A request to certify a course must be approved by the agency administrator.  If the course offers training in legal 

issues and subjects relating to legal liability, the legal advisor of the agency must approve the course. 
 
4. A training course offered by a private vendor, must be sponsored by a law enforcement agency, accredited college or 

university. 
 
5. All POST certified courses require a class roster (POST Form AD-10A) of attendees and course evaluations (POST 

Form AD-10B) be retained on file for inspection.  
 
6. An agency whose course is currently accredited by an organization, such as the National Accreditation Committee or 

the American Correctional Association which: 
 (a) Is nationally recognized, and 

(b) Gives accreditation to courses for peace officers, is not required to apply for accreditation of the course. 
 

7. The Commission on POST will not certify courses on a retroactive basis.  Courses should be submitted at least 30 
days prior to the commencement of the course.  

               
 

ONLY CORRECT ELECTRONIC FORM SUBMISSION WILL BE ACCEPTED  
 
Course Certification forms must be submitted electronically.  After reading the attached  
User Manual, click the following link to download the necessary Formatta Filler software and 
access the form: 
 

http://eforms.post.state.nv.us/efm/catalog/publishedforms.jsp 
 
 

Note:  Upon certification, the submitting agency/vendor will received a copy of the submitted Course Certification 
form; which will include an assigned POST certified course number. 

 



 

 

 

 

 

 

 

 

Using the Formatta Forms:  
Course Certification and 

Course Change or 
Decertification  

 
 
 
 

Doc Date: June 21, 2012 

 



Using the Formatta Forms:  Course Certification and Course Change 
or Decertification 

Table of Contents 

 

i 

Table of Contents  
Table of Contents ........................................................................................................ i 
Chapter 1 – Introduction ............................................................................................. 1 

What is Formatta?............................................................................................................................. 1 
Using the Formatta Filler Software...................................................................................................... 2 

Bubble Tips ................................................................................................................................... 2 
Pop-up Date Calendar .................................................................................................................... 3 

Chapter 2 – Setting Up Your Computer......................................................................... 4 
Download the Formatta Filler Software ............................................................................................... 4 

Add a Shortcut to your Desktop ...................................................................................................... 4 
Start the Download........................................................................................................................ 5 

Install the Formatta Filler Software..................................................................................................... 6 
Chapter 3 – Course Certification Form .......................................................................... 8 

Agency/Vendor Information............................................................................................................ 9 
Course Information ........................................................................................................................ 9 
Form Submission ..........................................................................................................................10 
Course Approval ...........................................................................................................................11 

Chapter 4 – Course Change or Decertification Form..................................................... 12 
Agency/Vendor Information...........................................................................................................13 
Course Change Information ...........................................................................................................13 
Form Submission ..........................................................................................................................15 

Index....................................................................................................................... 17 

 



Using the Formatta Forms:  Course Certification and Course 
Change or Decertification 

Chapter 1 – Introduction 

 

          1 

Chapter 1 – Introduction 
The Nevada Commission on Peace Officers’ Standards and Training (POST) is charged with keeping 
information on law enforcement agencies, courses, and officers throughout the state of Nevada.  In 
order to keep this information current in the POST database, agencies must apply for course 
certification and provide changes to course information timely.   

To make this process easy and efficient, POST has implemented an automated software solution 
that allows entering requests for courses to be POST certified and also to submit changes to a 
course that exists in the POST database and has been assigned a POST certified course number.   

What is Formatta? 
Formatta is the name of the electronic forms software implemented by POST to facilitate the process 
of updating POST with information.  It is user-friendly, electronic form filling software that will allow 
agencies to enter, save, and submit certain requests and changes to a certified course; which will 
update the POST database.  Agencies and vendors will access the POST Formatta form via the 
Internet and download the Formatta Filler software, which enables them to fill out, save and submit 
forms for their courses.  

When a course information changes, the responsible agency or vendor provides POST with the 
information that is changed using the correct Formatta form.  There are four steps to accomplish 
this; which are discussed in this document: 

1 Download and install the Formatta Filler client software on the agency computer. 

NOTE  Step 1 is completed only one time per computer that will be used to submit Formatta Forms. 

2 Using your Internet browser, access the POST Formatta Available Forms web page. 

3 Open the applicable form and log in. 

4 Enter the course information and submit.   
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Using the Formatta Filler Software 
As you work with the Formatta form, you can save work-in-progress and come back to it later for 
completion, or save a completed form for your records.  From the File menu, select Save As…  and 
give the form a unique file name so you can find it when you need to.  You can also print the form 
by selecting Print…. from the File menu and selecting your printer. 

  

Bubble Tips 
Bubble Tips are available for every field, checkbox, and button in the form. When you click in a field, 
select a checkbox, or click a button, an explanation will pop-up to assist you with the entry.  

 

 

 

You can turn the Bubble Tips feature off and on by selecting Bubble Tips from the View menu. 
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Pop-up Date Calendar 
When you click into the Date field of a form, a calendar pops up allowing you to select a date. Use 
the arrows at the top to scroll through the months and years to select the correct date. 

 

You can turn the Calendar feature off and on by selecting Calendar from the View menu. 
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Chapter 2 – Setting Up Your Computer 
The first step in using the POST Formatta form, is for the agency to download and install the Formatta Filler 
client software on a local computer Downloading and installing the Formatta Filler software is required only 
once on any computer that will be used to submit Formatta forms to POST. 

Download the Formatta Filler Software 
1 Open the web browser on your computer. 

2 Enter http://eforms.post.state.nv.us/efm/catalog/publishedforms.jsp into the address bar. 

You will see the following web page: 

 

Add a Shortcut to your Desktop 
3 Before downloading the software, right-click anywhere on the web page and from the menu, select to 

Create Shortcut; which will put a shortcut icon on your desktop so you can easily access this web page 
in the future. 
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The shortcut on your desktop will look something like:      

4 You can change the icon and rename it like any other shortcut on your desktop to make it easy for you to 
identify and quickly access the POST Formatta forms. 

Start the Download 
1 From the Available Forms web page, click on the Formatta Filler Free Download button located in the 

middle of the page. 

 

 

 

 

The File Download – Security Warning pop-up message appears.  

 

2 Click the Save button. 
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3 From the Save As dialog, save the FillerSetup.exe to your Desktop folder. 

 

4 Once the download completes, find the FillerSetup.exe icon on your desktop. 

It should look something like this:  . 

Install the Formatta Filler Software 
1 Close all programs that are running on your computer. 

2 Double-click on the FillerSetup.exe icon to begin installing Formatta Filler software on your computer.   

NOTE  You may need I.T assistance if you do not have install permissions on your computer. 
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The Open File – Security Warning  pop-up message appears. 

 

3 Click the Run button 

4 Follow the directions for installing the software on your computer. 

5 Once the Formatta  Filler software is successfully installed on your computer, you can delete the 
FillerSetup.exe from your Desktop folder. 
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Chapter 3 – Course Certification Form  
After the Formatta Filler Software is successfully installed on your computer, you can open the Course 
Certification form, enter the course information, attached any required files, and click the submit button to 
send the course certification request to POST. This form should be submitted to request POST certification for 
any course. 

NOTE  A new Course Certification form MUST be completely filled out and submitted for each course 
requesting certification.  

1 Double-click the shortcut you created on your desktop to access the POST Formatta  Forms   . 

Or, open a web browser and enter http://eforms.post.state.nv.us/efm/catalog/publishedforms.jsp into the 
address bar. 

2 Click the form icon under the Download heading to open the Formatta form. 

 

The Course Certification form appears. 
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Agency/Vendor Information 

NOTE   Make sure all the information you enter is in correct sentence case. Use capital letters and 
lower case letters correctly.  

 

3 In the Agency ID Number field, enter the POST assigned number of the agency/organization that is 
conducting the course.  This is a 4 digit number assigned to all law enforcement agencies.  Skip this field 
if you are a vendor/organization that does not have this number assigned. 

4 In the Agency/Vendor Name field, enter the agency or company name that will be providing the 
course.  Please provide the division or any d/b/a name, if applicable.  

5 If you are a vendor/company conducting the course, in the Agency/Vendor Name field, enter the name 
of the Nevada law enforcement agency that is responsible for sponsoring/providing the course. 

Course Information 

 

6 In the Course Title field, enter the complete/formal name of the course. 

7 In the Total Course Hours field, enter the total time of the course duration.  
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8 Click the Attachments button to submit the required documents for the course. The documents can be 
in any file type such as TEXT (.txt), WORD (.doc), Adobe (.pdf), Images (.tif, jpg, bmp, etc.). 

The Attachments dialog box appears. 

 

Click the Add button to browse your computer/network and select files that you want to send with this 
submission.  Continue to click the Add button and select all the files to submit until the list is complete. 

NOTE  You can select a file from the list and click the Delete button to remove it, or you can click the 
SaveAS button to save a copy of the file to a different location. 

9 In the Additional Information field, enter any information that is important for POST to know when 
considering approval for the course.   

Form Submission 
The remainder of the form facilitates the form submission, and entry into all of the fields is mandatory.  The 
form cannot be submitted and you will receive an error until the information is entered into these fields. 

 

 

10 In the Submitter’s Name field, enter your first and last name.   

11 In the Submitters Phone field, enter a phone number including area code where you can be contacted.   
Enter only the numbers and it will be formatted for you.  

12 In the Submitters E-Mail field, enter an email address where you can be contacted and the approval 
confirmation sent. 
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Reset Form Button:  If you made a mistake and need to start over, Click the Reset Form button which 
will clear all of the fields.  Don’t click this button unless you really want to start over filling out the form. 

13 After all of the course information is entered correctly and all documents are attached to the form, click 
the Submit button.    

When the form is submitted successfully, the following Submission Status message appears displaying 
the tracking number assigned to the submission.  This is a internal number generated automatically and is 
used for software administration purposes.  You may want to record this number for your own purposes. 

 

14 Click OK. 

The following “Thank You for your submission” confirmation message appears. 

 

15 Click OK and you are returned to the completed form with the assigned Submission number displayed. 

 

16 At this point, you can save the current form for your records, enter the information for another course  
and complete another form for submission, or exit from Formatta Filler completely.  

Course Approval 
Upon course approval, an email message will be sent to the email address as designated in the original Course 
Certification form submission.  The email message will indicate the approval of the course and the POST 
certified course number that is assigned. A copy of the submitted form will be attached to the email message 
with the POST approval section completed indicating the POST course number and the date of approval.   
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Chapter 4 – Course Change or 
Decertification Form  
After you have submitted a Course Certification Form, and it has been POST certified, when you change a 
course or no longer provide the course, you MUST submit a Course Change or Decertification form so that the 
information POST has on file is always current and correct. 

1 Double-click the shortcut you created on your desktop to access the POST Formatta  Forms   . 

Or, open a web browser and enter http://eforms.post.state.nv.us/efm/catalog/publishedforms.jsp into the 
address bar. 

2 Click the form icon under the Download heading to open the Formatta form. 

 

The Course Certification form appears. 
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Agency/Vendor Information 

NOTE   Make sure all the information you enter is in correct sentence case. Use capital letters and 
lower case letters correctly.  

 

3 In the Agency ID Number field, enter the POST assigned number of the agency/organization that 
obtained the course certification.  This is a 4 digit number assigned to all law enforcement agencies.  Skip 
this field if you are a vendor/organization that does not have this number assigned. 

4 In the Agency/Vendor Name field, enter the agency or company name that obtained the course 
certification.   

Course Change Information 

 

5 In the POST Course# field, enter the number of the POST certified course and click the Lookup button; 
which will display the course name from the POST database. 
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6 Click the Effective Date of Change field and a pop-up calendar displays allowing you to select the date 
that this change became effective.  You can select the date from the pop-up calendar or enter it manually 
mm/dd/yyyy (month/day/year). 

7 If you are requesting decertification of the course, select YES from the Decertify/Inactivate this 
Course pull-down.   

NOTE  Selecting YES will decertify the course, inactivate the status, and POST credit will not longer be 
allowed. 

8 If the hours have changed for the duration of the course, enter the correct hours in the Change Total 
Course Hours To field.  

9 In A Brief Description of Documentation Change or Reason for Decertification is REQUIRED 
field, enter a brief description of the change to what document or why the course should be decertified.  

10 Click the Attachments button to submit the changed documents for the course. The documents can be 
in any file type such as TEXT (.txt), WORD (.doc), Adobe (.pdf), Images (.tif, jpg, bmp, etc.). 

The Attachments dialog box appears. 

 

Click the Add button to browse your computer/network and select files that you want to send with this 
submission.  Continue to click the Add button and select all the files to submit until the list is complete. 

NOTE  You can select a file from the list and click the Delete button to remove it, or you can click the 
SaveAS button to save a copy of the file to a different location. 
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Form Submission 
The remainder of the form facilitates the form submission, and entry into all of the fields is mandatory.  The 
form cannot be submitted and you will receive an error until the information is entered into these fields. 

 

 

11 In the Submitter’s Name field, enter your first and last name.   

12 In the Submitters Phone field, enter a phone number including area code where you can be contacted.   
Enter only the numbers and it will be formatted for you.  

13 In the Submitters E-Mail field, enter an email address where you can be contacted and the approval 
confirmation sent. 

Reset Form Button:  If you made a mistake and need to start over, Click the Reset Form button which 
will clear all of the fields.  Don’t click this button unless you really want to start over filling out the form. 

14 After all of the course information is entered correctly and all documents are attached to the form, click 
the Submit button.    

When the form is submitted successfully, the following Submission Status message appears displaying 
the tracking number assigned to the submission.  This is a internal number generated automatically and is 
used for software administration purposes.  You may want to record this number for your own purposes. 

 

15 Click OK. 
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The following “Thank You for your submission” confirmation message appears. 

 

16 Click OK and you are returned to the completed form with the assigned Submission number displayed. 

 

17 At this point, you can save the current form for your records, enter the information for another course and 
complete another form for submission, or exit from Formatta Filler completely.   
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